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1 Introduction

In this exercise (described in chapter 2 & 3) we will build a small web application that
provides the possibility to on-line retrieve and manipulate data stored in a database. We will
provide the user with some simple database operations:

¢ Basic DML commands such as:
SELECT

INSERT

UPDATE

DELETE

We will try to do all this by using two different techniques:
= ASP (Active Server Page)
= Servlets and JSP (Java Server Page)

The necessary steps for building the web application can be summarized to the following:
Make the database available on the computer

Create a web page that uses data from the database

Create one more web page the uses the database

Connect the two pages with each other

Go back to step three until the web application is complete

agrwdE

1.1 The Environment

To do all this we will use the following products (they are all running under Windows NT,
equivalent software may exist for other operating systems):

Netscape Enterprise Server This is a web server product that provides the possibility to

2.6 publish the applications on the web.

Chili'Soft ASP 3.0 This is a plug-in that activates the web server for ASP.
Without this plug-in the ASPs are just text files for the web
server.

IBM WebSphere This is the application server that takes care of servlets,

Application Server 2.03 compiles jsp-files, creates and manages sessions and database

connections. WebSphere Application Server is connected to
the Netscape web server.

IBM WebSphere Studio 1.0 This tool provides help for designing servlets, javabeans,
queries, and connections between all these. WebSphere Studio
generates some of the code, which can be completed in an
editor of your choice. NetObjects Scriptbuilder is the default
editor that is installed with WebSphere Studio.
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This is the database manager that has been used to create the
database used in the exercises in the following chapters.

This is the “bridge” between the database and the ASPs and
Servlets. ODBC Data Source Administrator can be found in

the Control Panel.

The following figure illustrates how the web server, the application server, the ASP plug-in,
and the database are connected to each other and to the internet. The web server is in charge
of receiving requests from clients and then forwarding them to the application server, which is

in charge of servlets and JSPs, or to the ASP plug-in which is in charge of ASPs.
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Figure 1 Environment components and their role
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1.2 Netscape Server Enterprise

On every machine (that is used for this course) there is a Netscape web server installed
(normally under c:\Netscape\SuiteSpot). This means that the machine listens on port 80 for
http requests. You can test this by starting a browser and trying the following URL.:
http://localhost/ or http://%nameofmachine% for example http://L269.dsv.su.se/

If the browser returns an error message then the web server may be stopped. If the server is
running the browser should show the default homepage:

7 Netscape Enterprise Server Home Page - Netscape
File Edit View Go Communicator Help

v« ¢ A X o < & 3N

Back Fomvard  Reload Home Search Metscape Print Security Stop

w§ " Bookmarks A Netsite:|http;jj|259_d3\,«_3u_se,-' v|@'What's Related
SMS-MTN [ Channels-Taw 5 Search Engines [ Myndighetsr 5 Mulimedia mm 5 Dive

-

NETSCAPE ENTERPRISE

An enterprise-strength wehb and application server for the intranet and extranet
that connects employees, customers, and partners to an organization's
information and weh-hased applications. It provides powerful
information-management and data-access services that integrate with existing
systems and resources.

WHAT'S NEW IN 3.67

Faster Petformance for OGI MEAPL and 351
Eock Solid Eeliability

Increased Scalabdity for Virtnal Servers
Iultiprocess Capability

Dwynatnic Log Eotation

Please note: The Web Publisher, Search, and Agents links below are activated by
enabling the corresponding feature in your Enterprise Server. If these links are inactive,
ask your server administrator to use the & dministration Server to enable that feature.

NETSCAPE WER PUBLISHER SOFHISTICATED SEARCH
Web content authors can easily ﬁ Search capabiliies let users search
| manage their files on a the text content and the file
T MNetscape Enterprise Server by properties of any document on the
using the Netscape Web Publisher to server. This provides great fezibility and
publish and organize documents and precision. For example, a user can find all

E|$| |Document; Done

= Username and Password Required | %]

The web server can be administered on port 14614:  Enter usermame for Metscape Administration at

For example: http://1269.dsv.su.se:14614/ 1269 dsv.5u.52:1 461 4:
username: admin User Mame: |
password: admin Password, |

(0]4 | Cancel

! The name of the machine is usually “L” and a three-digit number and it is written on the front part of
the computer tower.
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From here you can start and stop the web server.

7 Netscape Server Administration - Netscape

.
e =il

268.dsv.51.5:14614/admin-sen/hinfindex v G0

NETSCAPE SERVER ADMINISTRATION

Contact Netscape Help
Start and stop

_ the server
(GENERAL ADMINISTRATION

SERVERS SUPPQRB¥ING (GENERAL ADMINISTRATION:
Netscape<=nternrise Server 3.62
- Enter the servers
(B administration

Create New Netscape Enterprise Server 3.62

Migrate from previous
- Remove Server
version —_—

Another very useful feature here is the possibility to create aliases’ for directories or files so
that they can be accessed through http. For example we can create an alias (URL prefix)
called star and map it to the d:\star directory:

2 Using aliases can be very useful when managing a large and complex web site. For the servlet exercises in
this compendium it is recommended that you do not use aliases; servlets need to be configured for the
aliases.
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B Netscape Enterprise Server - Netscape

File Edit View Go Communicator Help

- » 4 at 22 = & @

Back Forward  Reload Home Search  Metscape Frint Security S

| wf Bookmarks & Netsite:[hitp://1269 dev su.ser14614/hitos 1269 bin/index ~| &7 What's Relsted
SMS-MTN L‘i Channels - Tawl L.‘ Search Engines L‘i Myndigheter L‘.’ Multiredia.rmm L‘.’ Diverse L‘.’ Music L‘.’ Help in sublect L‘.’ Diverse help L‘.’ EBo

g

N—

dditional Document Directories
Add Another Directory

Content
Management
Primary

D

4 o URL prefix:
Additional

'Do(‘ulnent http://l269.dsv.5u,ge,l |Star I
Tirectories
1 Map To Directory:

Manipulation
= = Apply Style: INONE 'I
Document

Preferences
URL Forwarding | Lo | | _Fese | | By | |

Hardware Viriual

| Current Additional Directories | —

Editl Rermove |Prei'1x: /caspagent
. Directory: C:/Program Files/ChiliASP/Samples/friendship/agent/content
Document Footer Ed|t| [ — | Prefix: /caspclient
Parse FITML Directory: C:/Program Files/ChiliASP/Samples/friendship/client/content
Cache Control Editl Remove |Pfefm: feasp401k . o
Trirectives Directory: C:/Program Files/ChiliASP/Samples/401k/content -
| |Document: Done Sk e @R @ 2| g

After pressing OK and applying the changes it will be possible to see the contents of the
d:\star directory with a web browser at the following URL.:

http://L.269.dsv.su.se/star/

# Index of /star/ - Netscape

File Edit View Go Communicator Help
<« @2 A & a SN
Back Forward  Reload Home Search MNetscape Frint Security St
" Bookmarks A NBtSitBZ|ht[pjl.l'l.l'l_zﬁg_ds\,a_su_sel.l'starl.l' vI 1" What's Related
SMS - TN Channels-Tad f Search Engines 5 Myndigheter O Mulimedia mm f Diverse [§ Music § Help

Index of /star/

HName Last modified 8ize Description

Parent Directory

file.html 18-Nov-95 11:27 0K
test.txt 18-Nov-9% 11:Z68 [}

(D [ =)

E’ﬁ| |Ducument: Done g_,ga P o e R
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1.3 WebSphere Application Server

To every Netscape Server there is a WebSphere Application Server attached. The WebSphere
Appserver is located under e:\\WebSphere\AppServer. The servlets that we will create later
have to be deployed on the WebSphere application server. WebSphere searches automatically
for .class (compiled java classes) and .servlet (servlet configuration) files in the
e:\WebSphere\Appserver\classes directory and the e:\WebSphere\Appserver\servlet directory.

WebSphere Application Server can be administered at port 9527:
http://localhost:9527

username: admin
password: admin

Useful information about WebSphere Application Server is also available at:
http://localhost:9527/doc/index.html

1.4 Chili!Soft ASP

Chili'Soft ASP is a plug-in that is also attached to the web server. This product does not
require any configuration.

For more information about Chili!Soft ASP:
http://localhost/caspdoc/Index.html

1.5 WebSphere Studio

WebSphere Studio is a tool for creating most of the necessary files for web applications based
on servlets and JSPs. Studio can also be configured so that it can “publish” all the publishable
files (what it basically does, is copy them) to predefined directories where WebSphere
Application Server and Netscape Server can find them. That can be set in the Options >
Publishing servers menu:

- ¥ WebSphere Studio

File  Edit View

Source control... 0jectsiFlowerShop

File extensian... Mame | Size Modified | i 3
Show (04 window 0 :

Welcome... @
A I 3 [

_|1 ohjects |0 hvtes
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+# Publishing Server Settings - # Edit Publishing Server Settings

Select a publishing server and click Edit, Dalate, ar Duplicate. Mame ILD[;a|
Or, click Add to define settings far a new puhlishing server.
Add... £ Rermote & Lacal
Host Settings

Delete | oot I
Duplicate | User|d|

Password |

Publishing targets

Qk | Cancel |

Name Path add |
htrml cWebSpherelStudi . T |
classes cWebSpherelStudi...
isp CWebSphereiStud... BrOWEEL. |
Rl 2|

Advanced...l OK | Cancell Help

Here you can define the “publish”-paths for different types of files®.

All classes and servlet files should be published to c:\WebSphere\Appserver\classes

All html, jsp, gif, jpg etc. should be published either to c:\Netscape\Suitespot\docs (which is
the default document root for the web server) or to a directory that you have mapped with an
alias from the web server (see section 1.2 on page 5).

WebSphere works with projects. Every project is saved in a directory with the name of the
project under c:\WebSphere\Studio\projects. This location can be redirected:

% Preferences | x|

Directories | CUmpiIErI Helpl

Project directory [o:iWehSphere\Studiolprojects Browse... |

File ternplate directory. [cwvenSpherelStudictiemplates Browse... |

Projecttemplate directary [cutiebSphereiStudioterplatesiproject Browse... |

Ok | Cancell Help |

% Notice that a whole folder is assigned to a publishing location and that all the publishable files are
published to the associated location. You don’t need to worry so much about the publishing, Websphere
Studio is quite good at publishing the right files to the right place.
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Together with the directory where the project files are located, there is two more
configuration files:

ELd Prooram Files [Ldis®
A RECYTLER o hoendnd

Ly Saiishame il
- SM8 (Qstars project directory
CoEe0 BOLLE JIC

Loadicdats Dethiigse
e ]
[mibingensbogusr

Cmlliiiemp
SR MG

_.[_1 WebSphere
L E LT AnnTanar
Sl adar
{a s PHEEETS
L Seiyniteg

4 fite
starb3 wbprj
|#] star63.wbprj.usr

project configuration files

b U b ase
[®] U dotetiaiokase sbipr
UpdnialCatebase o oprpusr

You can back-up your project by copying these three items (project directory & project
configuration files).

WebSphere Studio also provides Wizards that guide you through the most common steps of
creating JavaBeans, servlets, SQL statements, html and jsp files. We will explore these
features in more detail later.

The documentation of WebSphere Studio can be accessed with a web browser at:
c:/WebSphere/Studio/DOC/html/2tabcontents.html

1.6 Other tools

Other relevant tools are:

e ScriptBuilder - for editing .html, .jsp, .java, .servlet, .asp files
ScriptBuilder provides some support on those types of files.

e MS Access — to explore and alter the database
The database used in the following exercises can be downloaded from
= http:\\L238.dsv.su.se\courses\stjarnaé3 or
= \DB-SRV-1\StudKursInfo\x63 Ht2001\ASP-Servlet Laboration

e ODBC Data Source Administrator
For creating an ODBC alias for a database so that servlets and ASPs can access the
database. The ODBC Data Source Administrator can be opened from the control panel.
When you register an alias make sure to place it under the System DSN tab, so that the
servlets and ASPs can find it:

10
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¢10DBC Data Source Administrator

User DSH iIe'DSNl Dirivers | Trau:ing' Connectian Pooling | About |

System Data Sourceg!
Mame | Drivel \ |

Microsoft &ccess Driver . mdh) BEemove
| Microsoft Agcess Driver (. mdh)
School Microsoft Acgess Driver (* mdh) Canfigure...

i

An ODBC Bystem data source stores infarmation about how to connect o the
indicated data provider. A System data source is visible to all users on this
machine, including MT services:

0K, I Cancel Aranlyy Help

2 Database

In chapter 3 and 4 we will build two small applications that connect to a database with
information about books, authors and book owners. This database is built in MS Access and
includes some test data. The following figure illustrates the tables of the database as well as
the relationships between them:

owner |, bookitem book
address mainauthor =——"" " |manauthor
postalcode OWTIEr category

city copynumber publisher
country datenfpurchase year

phare language originallanguage
birthdate edition isbin

11
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Owner Includes data about people that own books

Publisher Includes data about publishers

Author Includes data about authors

Book Includes data about books. A book is identified by its name and main
author.

AuthorsOfBook  Includes data about additional authors of books. This table has been
added in order to remove the many-to-many relationship between books
and authors.

Bookltem Here we have all the copies of a certain book with their attributes (that
differ from copy to copy) for example their owner.

2.1 Connect a database
To use the database in our web applications we need to do the following things:

1. Download the database from
= http:\\L.238.dsv.su.se\courses\stjarna63 or
= \\DB-SRV-1\StudKursInfo\x63 Ht2001\ASP-Servlet Laboration
2. Create an ODBC alias (also known as DSN) in the ODBC Data Source Administrator.

£ 0DBC Da*= Saurce Administrator

User DS UFile DSN I Drivers | Tracing | Connection Pooling I About |
Swstern Data Sources: Add
Marne | Driver
Bemowve |
Configure... |

Create New Data Source

Select a driver for which you wantto set up a data source.

MNarme | Version ]
IMTERSOLY 211 32-bit S0LBase 211.00.00
INTERSOLY 211 32-hit S0LSerer 2.11.00.00
INTE bl ase System 10 2.11.0000
" 211.00.00
i ] 35117130
An ODBC System data source ¢ crosoft dBase Driver (% di 35117130
indicated data provider, A Syet - 3R1171310
machine, including MNT senices Microsoft FoxPro Driver (*.dif) 31511715
Microsoft ODBC for Oracle 2.h73.2927

Microsoft Paradox Driver (*.db ) 3.51.1?1ii;|
[ = | : ' :

< Har Finigh Cancel |

12
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ODBC Microsoft Access 97 Setup

Data Source Marmeg? |labbs K. |

Description: datahase used forthe lab of *63 |

—Database |

Halm I

Database:
Select Database B
Select... Create... |
Database Name Directaries:

IbDDk.mdb d:hry documents’ i

3
—System Database Cancel |
backup hook mdh (= o, =l

= (= My docurments |
& MNone ~ S
¢ Datahase: Select the database file
that you have ™ Bead Only
Syetenm Dataks downloaded. " Exclusive
e
List Files of Type:
IAccess DatabasesT oo e] Rl = )] j MNetwiark |

Now the database is available through an ODBC driver.

3 Servlets

In this section we will build a project with servlets and JSPs. The following two functions will

be available:
= List all the books (title, mainauthor, isbn) and their publisher (name and country) ordered

by publisher, author and book title.
= Update the information of an author.
To do that we will use WebSphere Studio and its Wizards.

We can start by creating a new project in WebSphere Studio.

:r__i;_WebSphere Studio

Edit  Wiew  Opij Help
Mew project... m
= . + +
Open project.. ] = ‘ 8 "% @ q’j
Sawe all projects \ % Newr project | x|
SayE praEot =1
S = seneral | Type| 5 Control | Publish| M | B—Y%
Cluseprject vpe| Source Control| Fublis essage
IHessiles. L 4
Qe @
Ereyieyiile e festoz 2‘}3
Carmpilefile
HEBIEEr, Description jroject used throughout the compendium of *63 @
Addlfiles. L8511 |er Default package name |test63 ®
| Addidirectary, Project directory c:WWebSphersiStudioiprojects &
Euklist..
Exit d :
| OK Cancel Help |

13
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The name of the project used throughout this compendium is test63. We will use this project
as a container for all the servlets and JSPs that we will create. When the new project is
created, WebSphere Studio automatically creates a directory for the entire project and in that
directory another directory for all the classes.

- % WebSphere Studio
File  Edit Wiew  Opflons ools . Help . K
Proiect | Project location
ciWvebSpherelStudioiprojectsitesif
e ecten | Size | Modified [4
Z] classes 0 ,
q ®
Class directory I @
&
@
4| | —'I}T\
_|1 objects |n bytes

3.1 Using the SQL Wizard

When you want to create a servlet that provides database functionality, you first have to
specify an SQL statement and some database configuration parameters (user-name, password,
driver...). The SQL Wizard provides that.

v' Create a servlet that returns a table with the results of the following request:
List all the books (title, mainauthor, isbn) and their publisher (name and country)
ordered by publisher, author and book title.

To do that we can use the SQL Wizard to create an SQL statement that complies with that
request.

» Start the SQL Wizard! (Tools > SQL Wizard or the button on the right top side)

» Name your query! (For example selectl)

- ¥ SQL Wizard - c:\WebSphere\Studio\projects\test63\selecti.sql _[O] ]

‘Welcome | Lngunl Flmshl

Welcome to the SGL Yizard. The following pages
will guide you through building & SGL statement.

To get started, narme your SAL staternent and click Mext.

I select!

= Elackl Mext = I Fifish Cancel

14
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» Press Next and fill out the form according to the next figure:

. SQL Wizard - c:\WebSphere\Studio\projects\test63\selectl.sql [H=lEI

Welcome Logon | Finish]

Connectto a database

Database URL:

debc:odbc:lab63|

Llzerid: Passwiord:
Crriver; Cther driver:
I.JDEIC-ODEIC Bridge j ISun.jdbc.udbc.Jdchdthriver

Connect |

Enter the required infarmation and click 'Connect' to hegin.

<Back | wed= | Finisn | cancel |

» Press the Connect button to get to the next step. If the connection is successful then a list
of all the available tables should come up:

¥ SQL Wizard - c:\WebSphere\Studio\projects \test63\selecti.sql [H=lE
welcome| Logon Tableleoinl Columns| condition 1] Sort] saL| Finish|

Select an S0L statement type and table(s).
Statement type:

(: Select F Select Unigue F I=ent lﬁ hdate F [Velete

Select Tahleis):

Tahle narme |
MEysACES =
|_ MSyshodules
|_ MSyshlodules?
[ MZysObjects
|_ MSysQueries
hiSysRelationshins b

Filter table(s)... |

< Back | wei= | | Finisn | [cancel |

» Select the tables that should be involved. (in this case book and publisher)

» Press Next to go to the “Join” tab. Here you can define rules for joining the two tables
(basically for the foreign keys).

15
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% SQL Wizard - c:\WebSphere\Studio\projects\test63\selectl.sql H=lE
wieleome| Lagan| Tables Join | Calurnns| Candition 1] Sort| saL| Finish|

Shaowe how the tables are rel# by joining thern.

o 1} |

= | =

address Unjain |
nstalcode

Em, Options. |

country

hoak

publisher

L

title
mainauthor
category

year
ariginallanguage

iskn phone 1. Mark the attributes that you
want to connect in both
A tables.

InnerJoin: Only include rows where the ol 2.  Press the Union button

|<_\;|

Joined ‘hook publisher and ‘publisher pnarme’.

<Back | Next> | Finish | cancal |

» Press Next to go to the “Columns” tab.

» Include the columns that are requested. (e.g. book.title, book.mainauthor, book.publisher,
publisher.country, book.isbn)

-¥ SQL Wizard - c:\WebSphere\Studio\projects\test63\selectl.sql M=l
welcome| Logan| Tables| Join  Calumns | candition 1] Sort| saL| Finish|

Selectthe columns you wish to include.

Selected tableis):

publisher =

Columns:

Columns toinclude:

hoak title
pname

address Aol == | hoak mainauthor
talcod hook publisher
FJ_US o == BEfmaye | hook.ishn

o publizsher.country
phone selectall |

Deselect all |

e up Il e E

» Press Next to go to the “Condition” tab.

» You can leave the conditions empty.

16
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» Press Next to go to the “Sort” tab

» Here you can define which column(s) the result should be ordered by.

-¥ SQL Wizard - c:\WebSphere\Studio\projects\test63\selectl.sql [H=lE3
Welcomel Lugnnl Tablesl Joinl Culumnsl Candition 1 Sﬂﬁl SQLI Finishl

Select how you weant the resulting rows and columns sorted.

Columns: Sart order:

hook.ishn IAscending j
publisher.cauntry

Calumns ta sorton:

(a-=2) hook publisher

Ad == |
== Remove |
Select all |
Deselect all |

(a-=2) hook title

hove up hi o doen

<Back | Mext» | Finish [ cancel |

» In the next tab you can see the SQL statement that you have graphically built.
» You can now hit the “Finish” button.

A new file has been added to the project containing all the information about the SQL
statement:

- ¥ WebSphere Studio
File:  Edit ‘view Options Tools  Help

SEEO|L B 00 e @

cWehSpherelStudioiprojectsite stea
o @ tests3 I Name | Size | Modified | Modi |4
o clagses tlaszes 0 @
L/ _ 1409 1999-noy-23 15:32:33 @
o
&
&
Bl | ¥,

I 1 objects selected I 1409 bytes

3.2 Using the Studio Wizard

Based on the SQL created by the SQL Wizard, the Studio Wizard can create a servlet, a
JavaBean and JSP. The following figure illustrates how these three components work together
to provide the web client with the result.
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1. a client requests the execution of a servlet
2. the servlet instantiates a javabean and saves it in the response
— 3. the javabean connects to the DB, executes a SELECT
statement and holds the result
— 4. the servlet calls a jsp file
Client 5. the jsp file is compiled together with data from the response

\ (and the javabean stored in the response)

6. the compiled jsp is returned to the client (as html)

Java Server

‘ Page

Figure 2 Inside WebSphere Application Server — Execution of a servlet
» Start the Studio Wizard. (Tools > Studio Wizard)

» Choose to create a Database access servlet and press Next.

- ¥ Studio Wizard _ O] x]
Welcome |SQL Statement' Inputpage' Inputlayout' Outputpage' Outputlayout' EuEtanm errori

Welcome to the IBM Studio Wizards. These wizards are the
fastest and easiest way to custornize your YWeb applications.

What would you like to create?

Datahase access senvlet
Basic zervlet using a JavaBean
Expiring HTML =ervlet
Registration servlet

JavaBean

= Hack | Mext = | it | Cancel

» Give the servlet a name. (e.g. selectservlet)
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- % Database Access Wizard

Welcorme | Sl statement' Inputpage' Input layout| Output page | Output layout| Custom errorpage' Finishl
This wizard will create a servletthat accesses database infarmation.

To get started, name your servlet and click Mext.

Mame

Iselectservlet

Java package

|test63

Comment

|ﬂrst senlet uses a simple select statement

Qutput folder

Ic:IWebSphere‘tStudio‘tprojects‘ttestﬁS Browwse. .. |

<Back | wed= | Finish | cancel |

Stockholm
November 2001

® The Java package property is normally the same as the project name. In projects with

many servlets it can be good to have a better structure of java packages.

> Press Next.

» Choose the SQL statement that was created by the SQL Wizard before.

- ¥ Database Access Wizard [_[O] %]

Welcome SGAL statementl Inputpagel Inputlayoutl Outputpagel Outputlayoutl Custom errorpagel Finishl
Which SQL statement would you like to use?

& Selectfrom an active praject

[ Lookin all open projects

" Select from the file system

Hrowwee.. |

<Back |iTHeEs | Fmish | cancel |

» Leave the next four tabs as they are and go to the “Finish” tab.
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- % Database Access Wizard [_ O] x]

Welcnmel Sl Statementl Inputpagel Inputlayoutl Outputpagel Outputlayoutl Custom error page Finishl

Your database access servetis now complete.

Click Finish to save your files and return to 1BM WehSphere Studio.

You can change the following generated filenames:

Servlat [SelectServiet java

Diata access Bean |SelectServIetElean.java

Input page |SelectsenfletlnputPage.htmI
Cutput page |Se|ectsenrlet0utputPage.jsp
< Back [T HEHETT | Finish | Cancel |

Here you have the possibility to choose the filenames for all the components that are about to
be created. The Input page is just an html page with a button that calls the servlet. The Data
access Bean is a javabean that makes the connection to the database and executes the SQL
statement. The Output page is a JSP file that gets the information from the javabean and
formats it into plain html. The servlet is the connection between all the other components. It
receives and handles a request, instantiates the javabean and initiates a response (see Figure
2).

» Press Finish!
All the files have now been created and the classes have been compiled. It is now possible to
edit these files, for example to make design changes. For now we will not make any changes.

The only thing remaining is to publish the files.

» Mark the project, right click on it and choose Publish...
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| % WebSphere Studio
File Edit View Options Tools Help

| = cWebSphere\Studio\projectsitests
[ Mame | Size | Modified | modified By | e |4

Publish... classes 0 _
Refresh @
Save project /] & selectt.sql 1409 198%-nov-23 15:32:33 8
Close project @ @ SelectservletOutputPage.jsp 1275 1998-novw-26 11:59:44 5&
Copy /] SelectservletinoutPage. html 404 1999-nov-26 11:59:45 @
Easte .# Select Publishing Server &
Delete @

.. Selectthe publlsmng ser\rerto use and click Continue.

w O, click Edit ta ch gilings for the selected samvar

Se

| Edit. |

Total number of files to publish: 5 Details |
] —— e R0 Publish to 1238

“erify the puhlishing server setlings.
Change these values to tempararily override the stored settings

_| 4 ahiects | 3038 bytes

> Choose the Publishing Server that you have T Path Files
. . htrml CiL238-Homepageldocs 2
Conflgured (See section 15) classes CWebSphersldppServericlasses |3

> Press Continue and then Publish.

You should get a message that you may need to restart g7 Publish | _ Cancel | Helo
your web server.

» Press OK.
It should now be possible to run the servlet.

» Start a web browser and go to the following URL.:
http://%nameofmachine%/%InputPagePath%%InputPageFilename%
Where  %nameofmachine% is your machine’s name, e.g. L269,
%InputPagePath% is the path to your input page, starting from the web server’s
root. In this case nothing,
%InputPageFilename% is the name of the input file generated by WebSphere
Studio. In this case SelectservletinputPage.html.

For example http://1238/selectservietinputPage.html:

21



Institutionen fér Data- Databases & Internet Laboration v. 2.1 Stockholm
och Systemvetenskap *63 November 2001
SU/KTH Relationsdatabashanteringssystem

nikos dimitrakas

File Edit View Go Communicator Help

<« ® A 4 = <+ & @

Back Forward  Reload Haome Search  MNetscape Frint SEcurity =]ie]e]

W " Bookmarks & NEtSiTEZ|http:,.",."L238,."Selectsewletinputpage_html vI & What's Related
SMS-TH 3§ Channels-Téd 5 Search Engines [F Myndigheter f Multimedia,mm [ Diverse [ Music F He

Please complete the form and click Submit.

Subrmit | Resat |

& == | Document: Done = e ML 2P M- | 4

> Press Submit.

¥ Output page for serviet Bean: test53.SelectServiet - Netscape
File Edit View Go Communicator Help

1 4 ¥ 3 A a & & B
Back Fomvard Reload Horne Search  MNetscape Frint Security Stop
7| - Bookmarks A Netsite |http:IILESEJ’SENIeUtestEB.SelectServlet vI &7 What's Related
7 SME-MTH 4 Channels-Tawl 4 Search Engines 0§ Myndigheter 5 Multimedia mm 4 Diverse 4 Music (4§ Helpinsublect 4 Diverse help f BookStores [
title mainauthor publisher isbn country
Coneepts of programming Robert W. Sebasta Addison-Wesley 0-8053-7133-8 Usa
languages
Sangfigeln firdn Milano Annette Kullenberg Bra boker n'a Sweden
Rabbit Redux John Updike Forum 91-37-09391-6 Sweden
Rabbit Run John Updike Forum 91-37-09390-8§ Sweden
Management Systems Coneeptual | pio p gchoderbek Trwin 0-256-25166-5 Us
Considerarions |
Dédliga Data Hakan Borgstrém Natur och kultur 91-27-02803-8 Sweden
System Analysis and Design Kenneth E Kendall |Prentice-Hall International 0-13-654229-8 UK
Vagentill C Ulf Bilting Studentlitteratur 91-44-26732-0 Sweden |
E’ﬁ\ 7 7|D7|:||::urmernt: D;Jne 7 7 7 o g ik Y SP 3 N2 | 4

This is the default layout of the output page. It can easily be changed by editing the
selectservletoutputpage.jsp file. To edit it you can double click on the filename in WebSphere
Studio.

A jsp file is very similar to an html file. In addition to the usual html tags there are tags that
help to access the javabean. Such tags appear in selectservletoutputpage.jsp:

<BEAN> <REPEAT> <INSERT> <% %>
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When editing jsp files be careful with those tags. If they are not correct, the server will return
an error. After making changes you have to republish the altered file(s).

3.3 Updating data

Updating data can be a little more complicated. WebSphere Studio cannot create all the
components needed to insert, update and delete data.

In this section we will create three servlets for updating the information of an author:

1. One that shows a list of all the authors in the database so that the user can choose one.

2. A second servlet that shows the information stored in the database for the selected author,
so that the user can change it.

3. A final servlet that commits the changes to the database.

The first two can more or less be generated by WebSphere Studio. The third servlet requires a
little coding.

3.3.1 Showing all authors
This part is similar to sections 3.1 & 3.2.

» Create in a similar way a servlet that shows the names of all the authors.

® Create an sql with the SQL Wizard.
® Create a database access servlet with the Studio Wizard.
® Use smart filenames, think that there is going to be around 15 files.

® Don't forget to publish your project.
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When you are done you should have a servlet that produces a result similar to the following:

7 Output page for serviet Bean: testc63.UpdatelServiet - Netscape _ (O] x|
File Edit Wiew Go Communicator Help

- w® A N = =1 =y @b
Back Forwardd FReload Home Search Metscape Print Security SO

T W Bookmarks & Netsite:[htp//1236/serdet/testia Update 1 Servet ~] &" what's Related
SMS-tTH [ Channels -Té f Search Engines O Myndighater O Multimedia mm 2§ Diverse |

aname

Aaron Spelling
Annette Kullenberg
Amika Bomark
Arthur Conan Doyle
Asterios G. Kefalas
Astrid Lindgren
Charles G. Schoderbek
Douglas Adams
drte
Ernest Hemingway

Ernesto Santiago
Gunnel Linde
Henrik Koestner
Hakan Borgstrom
James Woods

Jan Skansholm
John Updike
Julie E. Kendall
Karsten Alnaes
Kenneth E Kendall
nikos dimitrakas
Peter P. Schoderbek
Roald Dahl
Robert W. Sebasta
Ulf Bilting

=== 'Document: Done S M | 4

3.3.2 Showing selected author’s information

The second step is to show the information of the selected author. We can create an SQL with
the SQL Wizard that uses a parameter:

» Create a new sqgl with the SQL Wizard in the same way as before until the “Condition”
tab.

At the “Condition” tab, select the column that is going to be in the condition (the aname).
Select the condition operator (equal to).

Press the parameter button and give the parameter a name.

vV VvV VYV V¥V

Press OK.
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-¥ SQL Wizard - c:\WebSphere\Studio\projects\test63\update2.sql M=l
weleamne| Logon| Tables| Join| Columns  Condition 1 |sm| 5oL Finish|

Select a column, an operatar, and enter the values you want to find.

Selected tahleis): 5 Walues:

Iauthor vHis exacily equal ta } |

is after
ks iz after or egual to —
aname iz hefore
M iz hefore or egual to

country is hetween

cantain the characteris)
start with the character(s) LI
end with the character(s) 1| | i
iz hlank

iz not blank

>

Find... | Parameter..

In tahle ‘author’, -
find all rows in column ‘aname’ that
are exactly equal to ..

% Create a new par... [E1

Enterthe pararmeter narme below:

<Back | Next= | Finish | cancal | oK mtl

» Continue with the SQL Wizard as before.

» Create a database access servlet as before.

Now it is time to write some code!

WebSphere Studio has generated a javabean that has code for activating the parameter in the
sql. That code works with most databases but not with MS Access. Therefore that code has to
be replaced with some more primitive embedded SQL.

» Open the javabean in an editor (by double-clicking on it)

The following code can be found there:

/**

* Instance variable for the SQLString property

*/

protected java.lang.String SQLString = "SELECT \"author\".\"aname\", \"author\"\"birthdate\",

\"author\".\"country\" FROM \"author\" WHERE ( ( \"author\".\"aname\" = ?) )";

// Create placeholders for the parameters
metaData.addParameter("aname”, java.lang.String.class , 12);

i.r;i.tialize();

// Initialize the parameters for the query
selectStatement.setParameterFromString(“aname”, getAname());

The SQLString variable contains the SQL statement to be executed. In that statement there is
a question mark. That question mark is supposed to be replaced with the value of the aname
variable (the parameter). This technique is not compatible with MS Access.
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Instead we can build the SQLString first and then execute it*:
» Scroll down to the method called initialize().

» Remove the following rows of code:
// Create placeholders for the parameters
metaData.addParameter("aname", java.lang.String.class , 12);

» Scroll down to the method called execute().

» Remove the following rows of code:
// Initialize the parameters for the query
selectStatement.setParameterFromString(“aname”, getAname());

To replace the rows that we just removed we can add the following code to the method
execute(), exactly before this row

initialize();
Add the following:

SQLString = "SELECT author.aname, author.birthdate, author.country FROM author WHERE
author.aname = ” + aname + “"';

In this way we have built the SQLString before we initialize the database connection and MS
Access cannot complain.

» Save the file and compile it in WebSphere Studio (Mark the file and choose File >
Compile file).

» Publish the project (If you have already tried to run the servlet before the changes, then
you may need to restart the web server (see section 1.2)).

After all that is done, you should have a servlet with the following input and output pages:

7 Output page for serviet Bean: test63.Update2Serviet - Netscape

*.?I-_Netscape - |0 x File Edit View Go Communicator Help
File Edit Yiew Go Communicator Help 7 J g \3 /& A = & §§
: 4 2 N ' B?CK Forwerd Reload H“DmE Search  MNetscape Print Security Etap . _
Back  Fomward  Reload  Home Search  Metscape 7 w§ Bookmarks A Netsite: [nt:/ /1238 s enviet/tests 3. Ipdate2Ganet vlﬁ‘ What's Related
7| wf Bookmarks &  Netsie |http /1238 updit v|@'What's Ralated i SMS-MTN [f Channels-Tévl Cf Search Engines (5 Myndigheter [ Multimedia.mm [ Diverse [ Music [
o _ e _ e e
£ SMS-MTM [ Channels-Tavl [ SearchEngines [ Myndigheter AT birthdate country
Please complete the form and click Submit. Douglas Adams 1952-01-01 00:00:00.0 England
anée IDouglas Adans i IuI
Submit | Reset
FE= N, |Document: Done = 5 e wP 4| == [Document: Done B % =P @ 2|
\ g

* This technique is not as robust as using question marks for parameters, but the aim of this compendium
is to illustrate the db-web connection methods and not to build a robust application.
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Now we have to connect these to servlets. The user should use the output page of the first
servlet as an input page to the second. Similarly the output page of the second servlet should
be used as the input page to the third servlet. To do this we need to “merge” the output page
of the first servlet with the input page of the second servlet.

The input page of the second servlet is quite simple. It is an html file with a form. The form’s
action calls the second servlet. The form has an input field for the parameter and a submit
button.

The output page of the first servlet has a loop (<KREPEAT?>) for going through the result of the
SQL.

By combining these two we can get an output page that looks like this:

Please complete the form and click Submit.

Author name: | Aaron Spelling x| Submit |

Aaron Spelling B
Annette Kullenberg

Annika Bomark

Arthur Conan Doyle
Asterios 5. Kefalas

Astrid Lindgren

Charles G. Schoderbel
Douglas Adams

drfe

Ernest Hemingway

Ernesto Santiago

Gunnel Linde

Henrik Kosstner

Hakan Borgstrém

James WWoods

Jan Skansholm b
John Updike

Julie E. Kendall

Karsten Alnaes

K.enneth E Kendall hd

3.3.3 Updating data

The third servlet is a little different. Instead of a SELECT statement it should contain an
UPDATE statement. Even though WebSphere Studio cannot create all the code needed, it is a
good idea to use the Wizards to create as much as possible. To do that we can create an SQL
statement (SELECT statement) that takes as parameters the same parameters as the UPDATE
statement would take (oldaname, newaname, newbirthdate, newcountry - ID for the old record
and all the new information).

» Create an SQL with the SQL Wizard.

» Set multiple condition by clicking on the “Find on another column” button
® Since the SQL Wizard does not allow you to create conditions on date columns, set
the condition on another column. We would anyway change the code... It doesn’t
matter if the sql doesn’t make any sense right now. We will just use this sql statement
to create a servlet and a javabean with parameter variables.
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» Create now a database access servlet with the Studio Wizard based on the new SQL.

We need to make the following changes to the generated files:

1. Change the javabean. Instead of a SELECT statement we should have an UPDATE
statement. There is a lot of code that can be removed: all the methods that have to do with
the result set (an UPDATE statement does not produce a result set).

2. Once there is no result set, there is nothing to show on the output page. We can modify
that page to some static html.

3. Merge the input page with the output page of the previous servlet.

» Start by opening the javabean for editing.

All the following variables and methods have to do with the result set and are therefore of no
use. Remove them:

Wwgfe static final int author_aname_COLUMN
private ic final int author_birthdate_ COLUMN
private static int author_country COLUMN
protected java.lang.3&ipg SQLString

public java.lang.Object getAuthoM™s
public java.lang.Object getAuthor_birt
public java.lang.Object getAuthor_co

.String poolname,
va.lang.String driver, java.lang.String URL, java.lang.String userlD, java.lang.S®¥gQg password)

There are also a few variables that take care of the database connection:

cted com.ibm.servlet.connm ConnMgr connectionManager;
ibm.se x mgr.1BMJdbcConn ibmJdbcConn;

.dp: tement selectStatement;

cted com.ibm.db.SelectResu

We will replace them with variables from the java.sgl package:

static protected Connection con;
static protected Statement stmt;

Add the following line at the top of the file:
import java.sql.*;
Also remove the following method:

public void initialize()
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This method established the connection based on the ibm classes. We will now add a method
for establishing a connection based on the java.sgl classes:

// establish DB connection
public void dbConnect()
{
try
{
// register the driver with DriverManager
Class.forName(getDriver());
con = DriverManager.getConnection(getURL(), getUserID(), password);
con.setAutoCommit(true);

}

catch (Exception e)

{
e.printStackTrace();

}
}

This method simply creates a database connection.

The main method of this javabean is the execute() method. It is this method that the servlet
calls to execute the SQL statement. We can change this method to first call the dbConnect()
method and then execute the UPDATE statement.

dbcConn.releaselBMConnection();

» And replace it with this:

dbConnect();

String query;

guery = “UPDATE author SET aname = " + getNewaname()+ *“, country = " +
getNewcountry()+ “, birthdate = CDATE(LEFT(" + getNewbirthdate()+ “, 10)) WHERE
aname = " + getOldaname()+ “"”;

stmt = con.createStatement();
stmt.executeUpdate (query);
stmt.close();

con.commit();

® CDATE and LEFT are functions that MS Access has. CDATE transforms a string to a
date. LEFT returns a sub-string. They can be omitted if there is some other code that
controls the length of the date parameter. Dates in MS Access are not exactly
compatible with the java.sql.date format.
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» Also change the declaration of the method to throw the appropriate exception:
public void execute() throws java.sgl.SQLException

When all this is done you should be able to compile the javabean without errors.
If you would now try to execute the servlet, it would return the output page which would
complain. That is because the output page is still configured according to the old javabean.

» Edit the output page and remove all the JSP specific tags that were supposed to show the
result set of the SELECT statement. Here is an example of how the output page could be:
<HTML>
<HEAD>
<TITLE>Output page for servlet Bean: test63.Update3Servlet</TITLE>
</HEAD>
<BODY>
<FONT SIZE="+3">BR>BR>
<CENTER>UPDATE statement executed!</CENTER>
</FONT>
</BODY>
</HTML>

The last thing is to connect the second servlet to the third.
Here is an example of how to merge the output page of the second servlet with the input page
to the third servlet:

Please complete the form and click Submit.

oldaname |

aname birthdate country newanarme I
Arthur Conan Doyle 1859-05-22 00:00:00.0 Scottland

newcountry |

newbirthdate |

Please complete the form and click Submit.

Name: IArthur Conan Doyle

Birthdate: |1859—DS—22 oo0:00:00.

Country; IScottland
Submit Query |

® The field “oldaname” is also present in the new form but as a hidden field!

After publishing the project you should have a chain of these three servlets:
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7 Netscape [M[=1 E3 (§i 3 output page for serviet Bean: test63.UpdatelServiet ... M=l [E1
File Edit Wiew Go Communicator Help File Edit View Go Communicator Help

| € 2 A 4 = = ﬁ 4w A 4 = pm
H Back Forward  Reload Home Search Netscape Print Se H Back Fomward Reload Home Search Netscape Print Se

f Bookmarks & Netsite: [fundatel seretinpupage himl |~ | &&17 What's Related 7 wf Bookmarks £ Metsite:[serdstiesthi Update | Servet |+ @507 What's Related
ShAS - MTH L‘.’ Channels - Tawl r_‘.’ Search Engines r_‘.’ Myndigheter r_‘.’ Multimedi v ShAS - MTH L‘.’ Channels - Tawl r_‘.’ Search Engines r_‘.’ Myndigheter r_‘.’ Multimedi

Pleaze complete the form and click Submit. Pleaze complete the form and click Submit.

Submit Resetl Author n 6 ~|  Submit
| .

|Document: Done S v o9 B 2 | 2

== |Document: Done Ha ws a9 ;@ 2 | | [FFE

. ]

e Edit View Go Communicator Help

- & a4 a4 = =9 Sen‘m

37 Output page for servlet Bean: test63.Update2Serviet ... M=l [E3

File Edit View Go Communicator Help

"' ”&“ \3 ﬁ A =5 i ; Back Famyard  Reload Horne Search  Netscape Print
Back fFonyard  Reload Home Search Metscape Print S — —
= «§ Bookmarks & Netsite 7 What's Relatad

wf Bookmarks i Netsite [serlet/iests 3. UpdarezSendet v| @ Whetgffelated | =
SMS-MTN ] Channels-Tavl (§ SearchEngines [ Myndighetgg®L§ Multimedi |

click Submit.

SMS-MTH [ Charnels-Tawl [§ SearchEngines [ Myndigheter [ Multimedi

Please complete the form and click Submit.

Please comy

fime: IJames Woods Junior

Birthdate: [1934-02-03 00:00:00.

ame: IJames Woods
Birthdate: |1934—UZ—U3 00:00:00.

7

untry: [Canada @rv: [Horth Fanada

Subrmit CITET

S e o0 B N2

, |'ﬁa|:m:| |Ducument: Done

|Document: Done

Eile Edit View Go
- @« A4 &4 =
Eack Fonward  FReload Home Search Print

i Bookmarks & Netsite |v\e[/|95(53_u|gdate F 4 @7 What's Related

7 SMS-MTN 4 Channels-Tavl (5 7|rgines 4 Myndighetar (4 Multim

UPDATE statement executed!

EiES] |Document: Done G % AP B 2|

4 ASPs

In this section we will try to create a set of ASPs to provide the same functionality as before.
ASPs work in a way similar to servlets. The following figure illustrates how an ASP is
executed:
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1. a client requests an ASP

_— 2. the ASP is prepared together with data from the
Client database
3. the ASP is returned to the client (as html)

.~ ASP plug-in

Active Server
Page

ASP result

Figure 3 Inside ASP plug-in - ASP execution

ASPs are very much like html files. In addition to the usual html content, an ASP includes
script commands within the <% and %> delimiters. The default script language is VBScript.
Everything that appears between those delimiters is executed on the server (in our case by the
ASP plug-in). An ASP can look like this:

<HTML>
<% name = “nikos” %> A variable “name” with value “nikos”
<BODY>
1 00— )
:?;OHS\J(:/" name%></B> |+ can be embedded to the html content. Use the <%= and %>
</HTML> to return the value of a variable.

After the script part of the ASP has been executed the ASP should look like this:

<HTML>

<BODY>

<B>Hej nikos</B>
</BODY=>
</HTML>

4.1 Accessing a database
To access a database with ASPs is very simple. The following two lines of code establish a
connection to a database:

<% Set db = Server.CreateObject(*ADODB.Connection™)
db.open “%0ODBC-DSN%’, “ %6user-name%’, “ %6password%s’ %>

The first line creates a connection object and assigns it to the variable name “db”. The second
line instantiates the connection to the specific database, through an ODBC DSN. The
user-name and password to the database can also be included.
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At the end of the ASP the database connection can be closed:

<% db.close
Set db = Nothing %>

To execute an SQL statement is also simple:

<%

SQLString = "SQL statement"

Set result = Server.CreateObject("ADODB.Recordset")

result.Open SQLString, db, 3, 3
%>

First create a string with the SQL statement.

Then create a variable to receive the result of the SQL statement.

Finally run the SQL statement on a specific database connection. The third and fourth
parameters of the “Open* function specify the following:

adOpenKeyset & adLockBatchOptimistic

In this compendium these parameters will always be set to 3.

Another method to execute SQL statements is this:

<% Set result = db.Execute("SQL statement™) %>

And of course if the SQL statement’s result is not important:

<% db.Execute("SQL statement™) %>

To navigate through a result of an SQL statement use the following functions:

Move to the first record:
result.movefirst

Move to the last record:
result.movelast

Move to the next record:
result.movenext

Move to the previous record:
result.moveprevious

To delete the current record in a result-set:
result.delete

To check the beginning and the end of the result-set:
result.bof, result.eof return true/false
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To loop through a result-set, writing a field from each record to the web page:
do until result.eof

=result("FieldName") (or result.Fields(“FieldName”))

result.movenext

loop

® To retrieve the value at a field of the current row of the result-set you can either use the
field’s name or its index position, starting with 0.

4.2 First ASP

Let’s now take the first question and try to make an ASP for it:
List all the books (title, mainauthor, isbn) and their publisher (name and country)
ordered by publisher, author and book title

To write an ASP file you just need an editor. It is recommended to use ScriptBuilder, because
it supports ASP files.

» Create a new file with asp as extension. Save this file at a location where the web server
can find it, for example in a directory called ASP under the web server root:
c:\Netscape\SuiteSpot\docs\ASP\file.asp

» Choose what design you want for your result and write all the static html code for it. If,
for example, you want to have the result of the SELECT statement in a table, you can
write the html code for the table and the titles...

Here is a possible design:

Book Publisher
Title Main Author ISBN Name Country
Data Data Data Data Data

» Add now some code at the beginning of the file to connect to the database:
<% Set db = Server.CreateObject(“ADODB.Connection”)
db.open “lab63” %>

» Also some code for creating and executing the SQL statement:
<%
statement = "SELECT book.title, book.mainauthor, book.isbn, publisher.pname, publisher.country
FROM book, publisher WHERE book.publisher = publisher.pname ORDER BY publisher.pname,
book.mainauthor, book.title"
Set resultset = Server.CreateObject("ADODB.Recordset")
resultset.Open statement, db, 3, 3
%>

Now we need to go through the result-set and populate the table. To do that, we need a loop.
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» Find the part of the code that you want to repeat for every row and include it in the loop.
For example:
<%do until resultset.eof%>
<TR>
<TD>
<%=resultset("title") %>
</TD>
<TD>
<%=resultset.Fields(1) %>
</TD>

<%resultset.movenext
loop%>

Everything that is included in the loop is going to be the ASP result once for every row in the
result-set.

» Make sure that there are matching <% and %> delimiters around the VBScript code
blocks. No html content should be within the <% and %> delimiters.

> At the end of the file add some code to close the database connection:
<% db.close
Set db = Nothing %>

When you call the ASP from a browser you should get something like this:

i All the books - Netscape _ Ol x|
File ELCdit View Go Communicator Help

[ - T TS & & 3

Back Fonward  Reload Horme Search  Metscape Print Security Siat

i w$ Bookmarks g Metsite: [ntp://localhosy asp/file asp -| &7 What's Felated

- SMS-WTH O Channels - Téwl 4 SearchEngines [ Myndigheter [ Mulimedia. mm 0§ Diverse 0§ Music F Helpinsublect 0 Diverse help 0
| Book | Publisher
| Title | Main Author | ISBN | Name |C0umiy
|C0ncepts of programming languages |R0bert W. Sebasta |U-8053-7133-8 |Addison-Wesley |USA
|S§ngf°ageln fran Milano |Annette Kullenberg |nj a |Bra boker |Sweden
[Rabbit Redux [Tohn Tpdike [91-37-09391-6 [Forum [sweden
[Rabbit Run [Tohn Updike [91-37-09390-8 [Forum [sweden
|Management Systems Conceptual Considerarions |Peter P. Schoderbek|0-25 6-25166-3 |It'win |US
|D6dliga Data |Hékan Borgstrom |91-27-02803 -8 |Narur och kultur |Sweden
|System Analysis and Design |Kenneth E Kendall |0-13-654229-8 |Prentice-Hall International |UK
[Viigen till C |UIf Bilting [91-44-26732-0 [Studentlitteratur [sweden
|The memoirs of Sherlock Holmes |Arthur Conan Doyle |nj a |Wings books |USA
|The more than complete Hitchhikers Guide |D0uglas Adams |0-517-693 11-9 |Wings books |USA
|The old man and the sea |Emest Hemingway |nj a |Wings books |USA

=== |Document: Done g G % SP BB NE | g

4.3 Updating data

The only difference when updating data is that the UPDATE statement is different every time.
In this section we will try to build the same structure as in section 3.3.
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First we need a page that shows all the authors and lets the user select one. That can be done
in the exact same way as before (with a SELECT statement). The only thing that differs is the
parameters that are sent from the one ASP to the next with a form. Example:

If you have a FORM that sends the name of the author as a parameter called “aname” then the
receiving ASP can access this parameter in one of the following two ways:

If the FORM used the POST method then the parameters can be accessed like this:
Request.Form("aname")

If the FORM used the GET method then the parameters can be accessed like this:
Request.QueryString(“aname”)

Another thing that may come in handy is string concatenation. The concatenation operator in
VBScript is the “&” character. Example:

<%

fname = “nikos”

Iname = “dimitrakas”

fullname = fname & “ “ & Iname

%>

» Complete this little application so that it behaves like the one in section 3.3.3.

5 Completed Lab requirements

The exercises in section 3 & 4 are compulsory. In addition to that, every group has to
create one more set of servlets or ASPs for inserting or deleting data (INSERT or
DELETE statement). Every group is free to choose their own statement and their own
design.

Latest on the 14™ of December, you should do a short (oral) presentation of your work.
Contact nikos to book time!

6 Internet Resources
Html

http://www.echoecho.com/html.htm
http://www.w3schools.com/html/default.asp

VBScript & ASP

http://asp-help.com/

Servlets & JSP

http://www-4.ibm.com/software/webservers/appserv/doc/v20dcstd/doc/index.html
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7 Epilogue

When all this is done, you should have a quite good understanding of how to use servlets and
ASPs for making databases available on internet.

I hope you have enjoyed this compendium. Please come with feedback!
The Author

hod dimitral
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